
Welcome to Flexi FAMILY 10 and PhotoPRINT 10 
 
Flexi and PhotoPRINT are some of the world's most advanced sign-making and digital printing software 

and we have added many new features based on your feedback. 
 
 
What is on this DVD? 
Most of the items on the DVD install with Flexi and PhotoPRINT or are accessible through the installer. 
The following items are loose on the DVD: 
\Acrobat: Adobe Acrobat 9 full English installation 
\Goodies - Samples from vendors that make SAi Certified Accessories 
\ICCProfile - Color management profiles for hundreds of printer models. 
\Util\Colorspan - Utility for Colorspan printer and drivers for Videonet network interface 
\Util Cut Server - Application for the Mutoh cutters to send bar code cut files 
\Util\Encad\Go - Application to send native (RTL) file directly to device from DOS 
\Util\Encad\EFPUv30 - Installer for application to send native (RTL) files from Windows. Includes an RTL 

viewer 
\Util\Eye-One driver - USB driver for Eye One colorimeter 
\Util\GetKeyID: Detects all SAi keys and reports back the user ID. 
\Util\Hasp\HASP_SRM_Runtime_cmd_line 
\Util\HP DesignJet 9000s USB driver - USB for the HP9000s printer 
\Util\Mimaki Firewire - Drivers for Mimaki Firewire port 
\Util\Monitor - Adds Hot Folder port to shared printers 
\Util\Seiko IP-5600 IP-6610 IP-6910 USB driver: Latest USB driver for Seiko IP-5600,IP-6610, and IP-

6910  
\Util\Sentinel - Rainbow key driver and utilities 
\Util\USB-PIA - Windows driver for Macintosh USB-PIA cable 
\Util\versacamm_ver.300 - Roland VersaCAMM SP-300 USB driver 
 
Operating Systems Supported 
• Windows Vista Home Basic 32-bit (x86) or 64-bit (x64) processor 
• Windows Vista Home Premium 32-bit (x86) or 64-bit (x64) processor 
• Windows Vista Business 32-bit (x86) or 64-bit (x64) processor 
• Windows Vista Ultimate 32-bit (x86) or 64-bit (x64) processor 
• Windows 7 Home Premium 32-bit (x86) or 64-bit (x64) processor 
• Windows 7 Professional 32-bit (x86) or 64-bit (x64) processor 
• Windows 7 Ultimate 32-bit (x86) or 64-bit (x64) processor 
 
 
Flexi 10.5.1 and PhotoPRINT 10.5.1 
Build 1806 
2 April 2012 
 
Improved Features 
• The PDF page boundaries preview now refreshes without having to close and reopen Job 

Properties  
• Input icc and rendering intent are now enabled for the alternative color space for input device N 

colors 
• Added support for the Barbieri Spectro Swing 
 
Bug Fixes 
• Overprint  and finisher effects now print correctly from Flexi 
• Presets now remain selected when maximizing the Job Properties dialog 
• OPOS marks no longer disappear when clicking the workflow tab in Job Properties 
• Fixed an error with output compensation for cutters 
• Files now rip correctly for the Gerber Edge 



• Files with embedded icc no longer print noise in the white area 
• Printing substrate, dimensions and labels options from RIP and Print dialog are now applied 
• Labels in Asian text now print correctly 
• Mutoh multi segment and barcode are now working correctly 
• Improved angled screen 
• Fixed an issue that certain JPEG files were not printed with correct dimensions 
• Spot channels in bitmaps and DCS files are now handled correctly 
• Applying saturation adjustment now keeps the white area as white 
• Sending Contour only to a hybrid device no longer contains print data in the job 
• Production Manager used over the network now keeps job offsets and number of copies 
• Fixed an occasional issue where jobs from RIP and Print dialog were sometimes printed with  
• wrong dimensions 
• Sending large bitmaps from RIP and Print dialog no longer locks up the application or reports 

error generating job 
• In FlexiSIGN + PlusPrint, the cut job is no longer deleted after finishing the print job of a contour 

cut file 
• Printing jobs with a negative Contour Cut path no longer creates a white path in the print data 
• Fixed an issue with the Roland VS-640 registration marks that would occur when the job size was 

smaller than 5cm 
• Production Manager now displays all pages of a multipage PDF correctly after Break Apart 
• Cut jobs are now positioned correctly on the GX-24 
• The adjustment curve stored inside a preset is now applied correctly when regional settings are 

not English US 
 
New Printer Drivers 
• GerPrint: GP 2000, GP 3180, GP 4180, GP 1604 
• Hewlett-Packard: HP Scitex LX820, HP Scitex LX850 
• Mimaki: JV34-260, TS34-1800A 
• SIDSigns: SID Mercury, Triton 180, Triton 210, Triton 210S, Triton 180S, SID TITAN, SID TITAN 

L, SID TRITON 250S, SID TITAN GT 
 
New Cutter Drivers 
• GCC: EnduraCut, SignPal Lynx III, SignPal Panther IV 
 
 
Flexi 10.5 and PhotoPRINT 10.5 
Build 1776 
1 January 2012 
 
New Features 
• PDF RIP engine.  This next generation raster image processing technology highly improves 

rendering of transparencies and allows to choose the page bounding box for PDF files 
• Repeat Job has been added to PhotoPRINT SE 
• Added Pantone Plus libraries 
• Added font size selection for barcode 128 
• Improved the nesting algorithm in Flexi to further optimize media usage 
  
Bug Fixes 
• Poll size on the printer tab of hybrid devices now updates the cutter media size 
• Preview now matches output when user has multiple copies of a contour cut job on a hybrid 
• Fixed an issue with manual nesting when the jobs were tiled for a smaller media size.  Now the 

pieces can also be moved 
• PDF files now apply correct rendering intent for embedded icc profiles 
• Fixed an issue in “Optimize by curve” that caused certain segments to move beyond the design 

area 
• Joining points no longer converts curves to lines 



• Fixed a preview issue with Object Color Control of negative CMYK images 
• Ink estimation now works on jobs with multiple pages 
• Paths with “CutContour” prefix in the color names are now recognized as cut contour paths 
• Advanced color mapping tolerance now works correctly on locales using comma separation 
• Global color mapping now works correctly on locales using comma separation 
• Fixed an issue with the HP L26500 and L28500 last used settings dialog appearing when no 

changes had been made. 
• Fixed an issue with multiple page targets for the Barbieri LFP3 

 
 
Flexi 10.0.4 and PhotoPRINT 10.0.4 
Build 1766 
23 November, 2011 
 
New Features 
• Barcode 128 can now be created in Flexi 
• Alternate colorspace for Pantone colors can now be set to RGB, CMYK or LAB on export to 

.eps.  Uncheck the Suppress Options box in the Export Dialog. Third party software that does not 
support spot color mapping will use the alternate colorspace values of pantone colors for printing   

• “Send to Roland Versaworks” command can now send to multiple printers 
• Support for the Barbieri LFP3 

 

Bug Fixes  

• Font names and color names no longer overlap when applying a template 
• DCS files can now be printed with labels and marks 
• Contour cut jobs on hybrid devices can now apply cut options for each color 
• The Rip and Print dialog now keeps the icc selection from the fs files 
• Fixed an issue where white would sometimes print incorrectly with CMYKLcLm+Spot Colors 

using an icc profile with SO diffusion. 
• Variable underbase with spot colors is now preserved when exported as EPS 
• The Roland GX mark now prints with nested cut contour jobs 
• Nested cut contour jobs with offsets or uneven resolutions no longer print or cut out of bound 
• Aborting more than 10 jobs at once now works correctly 
• Fixed an issue where PhotoPRINT would sometimes crash when clicking on the blank area on 

the setup bar 

 

New Printer Drivers 

• Asbru: Saga 1600 
• GerPrint :  GERPRINT DX 5, GERPRINT DX 5.5, GERPRINT 7701/7702L, GERPRINT DX5, 

GERPRINT DX 7 8C 
• Hewlett-Packard : HP DesignJet L26500 61, HP Designjet L28500, DesignJet T1300, DesignJet 

T790 44, DesignJet T790 24 
• Mutoh: VJ-1608AH, VJ-1604AG (ValueJet), VJ-1638, VJ-1638EU, VJ-1628TD EU, VJ-2628TD 

EU 
• Roland: VersaUV LEC-12, VersaStudio BN-20 

 

New Cutter Drivers 

• ArtCreation: ART-630H, ART-1200H 
• Cotek: COTEK-360C, COTEK-720C, COTEK-870C, COTEK-1100C, COTEK-1350C, COTEK-

1600C, UYDA-360C, UYDA-720C, UYDA-870C, UYDA-1100C, UYDA-1350C, UYDA-1600C, 
CTK-360A, CTK-720A, CTK-870A, CTK-1100A, CTK-1350A, CTK-1600A, YD-360A, YD-720A, 
YD-870A, YD-1100A, YD-1350A, YD-1600A, CTK-360C, CTK-720C, CTK-870C, CTK-1100C, 



CTK-1350C, CTK-1600C, YD-360C, YD-720C, YD-870C, YD-1100C, YD-1350C, YD-1600C 
• Creation-PCut: CTO-330, CTO-330G, CTO-630G, CTO-900G, CTO-1200G, CB-730, CB-1300 
• Foison: S60, S60-USB, AutoMark 
• GerCutter-Laser: BLUETOOTH CB730, BLUETOOTH CB1300, Gercutter Pro laser 
• GerCutter: CSV1350, CSV720 
• Helitin: 360BC, 500BC, 720A, 870A, 1100A, 1350A, 720B, 870B, 1100B, 1350B, 720BC, 870BC, 

1100BC, 1350BC, 720RB, 870RB, 1100RB, 1350RB 
• Jingwei: CB-1311, CB-1815, CB-2517, CB-3020 
• Mimaki: CG-75FXII, CG-130FXII, CG-160FXII 
• Rheinstern: LB-720A 
 
 
Flexi 10.0.3 and PhotoPRINT 10.0.3 
Build 1692 
8 July, 2011 
 
Improved Features 
• Increased size of the Cut/Plot preview area 
• Multipage PDF files containing contour cut are now handled correctly when adding to Production 

Manager 
• Added the Roland SC540 contour marks for Contour without RIP (Option) 
• PNG files can now be linked 
• The demo dialog will no longer stay behind the splash screen 
• The maximum number of copies has been increased from 1000 to 9999 
• Added support for the Mutoh SpectroVU for the VJ-1324, VJ-1624 and VJ-1608 
• The installation now allows you to choose which help files you wish to install.  This will reduce the 

total amount of installation time 
• Fotoba marks can now specify size, margins and density 
• Linked PDF now allows selecting resolution for preview 
• Cut/Plot easy weed now has the option to cut around groups and text instead of individual paths 
• Cut/Plot now h as the option to cut overlapping lines only once 
• Added RGB chart for RGB 8bit profiling.  Current devices with 8bit RGB handle ink limit and 

linearization inside the printer.  During profiling, keep ink limits to 100% and hit Neutral 
Linearization 

 
 
Bug Fixes 
• Transparency is now preserved when opening .png files in Flexi 
• Linking very large .png files no longer causes a crash 
• In Rip and Print the Media list now properly refreshes 
• Epson printers no longer feed media when a job that was set to Fit to Media was aborted 
• Fixed an issue with Light Magenta in the ink split of LcLmOG color modes. 
• Rip and Print now remembers the Registration Mark settings 
• Installing older versions of Flexi and PhotoPRINT no longer trigger messages about reloading 

font. 
• Auto tracing no longer produces jagged results on certain files 
• When using the Cleaver Tool, the outline of certain characters no longer disappears 
• Fixed an issue with True Shape Nesting that certain paths could not be nested 
• Flexi now uses the full space of dual monitors when the resolution of the second monitor is larger 

than that of the primary monitor 
• Spot_White can now be mapped to the printer white in instances of CMYK+lights 
• Closing Bezier paths now behaves correctly 
• Using the Cleaver Tool no longer converts other objects to outlines. 
• Fixed an issue that some jobs would stay on status Processing when Gradient smoothness was 

set to Enhanced 
• Objects no longer overlap when applying True Shape Nesting on grouped objects with multiple 



copies 
• Corrected the display colors of some swatches in the 3630 – Scotchcal Translucent Graphic Film 

Color pallet 
• Fixed a buffer overrun issue on some systems with Windows7 64bit 
• Flexi will default to loading the 32-bit version of Photoshop plugins as the 64-bit plugins cannot be 

loaded in Flexi 
• Used Colors in templates now scale to the placeholder 
• The Rip and Print dialog now reads the color adjustment settings from presets in Production 

Manager 
• The Twain Acquire scanning dialog no longer displays a “server busy” message when using a 

WIA scanner on Windows 7 64 bit 
• The Send Mail feature no longer fails when opening files of none native format and sending them 

as native. 
• On Win7 64-bit system, when printing to non-PostScript printers, the application no longer 

randomly crashes when printing designs with lens effect 
• In the RIP and Print dialog, the individual color bands can now be selected. 
• The contour cut paths generated through Arrange>Contour Cut>Make Contour Cut are now using 

spot colors for the strokes 
• Poll size now returns the correct values for the Canon iPF6350 and iPF300s 
• Fixed a crash in optimize by curve 
• Embedded ICC is no longer grayed out for PDF 
• The output now matches between Rip and Print and Production Manager for RGB 8bit icc profiles 
• Tiled cut jobs that have the auto weld option on will now cut completely 
• Fixed an issue with Error Diffusion that sometimes an extra arc shape would be in the output 
• Fill plot for letters now works correctly 

 
 
New Printer Drivers 
• Gerber: Solara ION X, Gerber CAT | UV 
• Hewlett-Packard: DesignJet Z6200 42, DesignJet Z6200 60, HP Scitex LX600, HP Scitex LX800, 

Scitex FB500, Scitex FB700,  DesignJet T7100, DesignJet T2300 
• Mimaki: JV33-260, UJF-3042 
• Mutoh: VJ-1608HJ, VJ-1324 (ValueJet), VJ-1624 (ValueJet), Viper TX Soft Sign, Viper TX 

Professional, VJ-1324EU (ValueJet), VJ-1624EU (ValueJet), Viper Extreme 65, Viper Extreme 90 
• Roland: VersaCAMM VS-640, VersaCAMM VS-540, VersaCAMM VS-420, VersaCAMM VS-300, 

VersaUV LEC-540, VersaUV LEJ-640 
 

 
New Cutter Drivers 
 
• Aristo: GL 2072-8, GL 2432-8, GL 3232-8, GL 3252-8, GL 4232-8, GL 4252-8 
• ArtCreation: ART-630E, ART-630S, ART-630P, ART-1200E, ART-1200S, ART-1200P 
• CutterPros: Servo 2400, Servo 4800, Contour 2400, Contour 4800, CR630, CR730, CR1200, 

CR1300 
• GCC: Expert-24 LX, Expert Pro-60, Expert Pro-132, SignPal RX-61, SignPal RX-101, SignPal 

RX-132, SignPal RX-183 
• GerCutter-Laser: CT-630, CT-900, CT-1080, CT-1200, CT-630G, CT-900G, CT-1080G, CT-

1200G, CR-630, CR-900, CR-1080, CR-1200, CR-630F, CR-900F, CR-1080F, CR-1200F, CS-
630, CS-900, CS-1080, CS-1200, CS-630F, CS-900F, CS-1080F, CS-1200F, MC-270, CS-630G, 
CS-1200G, DC240, SP Series 

• GerCutter: MH-365, MH-721, MH-871, MH-1351, ECO Series, PRO Series, CSV1350, CSV720 
• Goldcut: JK-721, JK-871, JK-1101, JK-1351 
• Omnisign Plus: PRO 600S, PRO 1200S, PRO 600S (U), PRO 1200S (U), PRO 600, PRO 1200 
• RF(GER) Cutters: DC-240, DC-330, MH-365, MH-721, MH-871, MH-1101, MH-1351, XL-1.0, XL-

2.0, XL-3.0, XL-4.0 
• Roland: VersaCAMM VS-640, VersaCAMM VS-540, VersaCAMM VS-420, VersaCAMM VS-300, 



VersaUV LEC-540, VersaUV LEJ-640 
• Saga: SAGA-360I, SAGA-550I, SAGA-720I, SAGA-1350I, SAGA-1600I, SAGA-2100I, SAGA-

2600I, SAGA-360II, SAGA-550II, SAGA-720II, SAGA-1350II, SAGA-1600II, SAGA-2100II, SAGA-
2600II 

• Vicsign: HW330, HW630, HW900, HW1200 
• Vinyl Express: R19, R31, R44, R48 
 
 
Flexi 10.0.2 and PhotoPRINT 10.0.2 
Build 1604 
31 December, 2010 
 
Improved Features 
• Improved split lines : hold down the CTRL key while dragging the split line to move the entire line 
• Improved behavior of modifying tangential curves for line to curve and curve to curve 
• Crop marks now apply to each item in a nested job 
 
Bug Fixes 
• The Plusprint option now includes all bitmap editing tools 
• Bezier path tool will now respect the curve of the last section 
• Using bitmap editing tools no longer makes the stroke and fill options in the bottom bar disappear 
• The shape of objects no longer changes depending on order of joining paths 
• Soft shadow now prints consistent color with the vector background 
• Fixed a crash when opening inspire .sci files 
• Make arc now snaps to guide 
• Fixed a crash that might occur when using Arrange > Resize without applying 
• Files with very small gradients now export correctly to .EPS 
• Rip and Print will now read the correct information for marks from presets 
• Ink estimation no longer crashes for Mimaki printers 
• Mutoh Kona cutter now displays in the correct parameters for tool up and tool down distance on 

non-english operating systems 
• Roland driver options are now applied when sending jobs from Rip and Print 
• Mutoh driver options are now applied with sending jobs from Rip and Print 
• Fixed Error 61 when sending jobs to the HP L25500 via Rip and Print  
• Fixed timeout issue for the HP L25500.  When the L25500 had to warm up from very cold, the 

first job would abort with an error 1609 on the printer display 
• Fixed an issue that HP printers would not accept german characters 
• Fixed an issue that sometimes nested jobs would overlap when positioning center 
• Presets that were generated in Flexi 8.6 or Photoprint 6.1 now respect the settings of the 

adjustment tab. 
• Panel to border : the preview will now show the spacing between copies 
• Fixed a crash that might occur when cutting files with a lot of overlapping lines 
• Fixed an issue that nested jobs would shift to the left when scaling 
• Fixed a crash that might occur with nested contour cut jobs 
• The Barbieri LFP now shows all ports in Color Profiler 
• Fixed an issue that color profiler would not display all charts for characterization 
 
Flexi 10 and PhotoPRINT 10 
Build 1577 
13 September, 2010 
 
New Features 
• Smooth Shadow.  Configure settings such as blending mode, opacity, blur amount, blur radius 

and resolution via the advanced button on the Shadow tab of Design Central. 
• Load fonts on the fly.  When a new font is installed, it is no longer necessary to restart Flexi.  A 

message will pop up asking if the new font should be added to Flexi. 



• Text outlines are now stored with Flexi .fs documents.  When an .fs file is opened for which the 
font is not available, Flexi will provide the choice between substituting the font and loading the 
outlines instead. 

• Make Transparent can now be applied to files of all color modes. 
• SignTracker connection.  Thumbnails of files can now be uploaded to a project directly into 

SignTracker. 
• PDF Link Option. A link option was added to the import dialog for PDF files.  Linking PDF files will 

display a low resolution bitmap while keeping the original intact.   Text and objects can be added 
to the file and the Make Transparent Tool and Contour Cut effect can be applied.  Flexi will apply 
these to the original while keeping the original colors, blends and transparencies intact. 

• Color Nesting.  This feature is an extra option on the layout tab of Cut/Plot dialog that allows 
nesting of each individual color for cut jobs. Use the Width field to determine the horizontal space 
that can be used.  The option Keep Text and Groups will keep all text and grouped objects 
together while nesting all other objects 

• Manual Split lines. Now add, move and delete Split Lines manually.  Right click inside the job 
area to bring up the menu to add split lines. Move split lines around with the mouse.  Right click 
an existing split line to bring up the menu to delete it. 

• Files with multiple contour cut paths can now be loaded directly into Production Manager.  The 
contour cut paths have to be spot colors. The naming convention is CutContour for the first path 
and CutContour1, CutContour2, etc for any subsequent contour cut paths.  In Job Properties, 
different settings for tools, speed, pressure, etc can be assigned to each of the cut paths. 

• Nest contour cut jobs that are added directly to Production Manager.  All jobs will be nested within 
one set of registration marks.  A preview of the cut path will be showing. 

• Badwrap Layered TIFF file support.  Select Files of type “TIFF for Badwrap” when opening the 
file.  Add your designs and logos to the different layers. 

• Ink Estimation. Calculate the estimated ink usage for a job based on rip data. The ink estimation 
button will be active for ripped jobs.  Configure price and volume of cartridges in the Config menu.  
Config also to set custom dot sizes for a device.  Define a clean factor or choose between pl and 
ml in Preferences.  The currency is read from the system locale. 
 

Improved Features 
• Holding down the CTRL key while using the scroll button on the mouse will now zoom in and out 

on the position of the cursor.  
• Smooth and symmetric attributes now work with line-curve/curve-line intersections. 
• Improved support of Adobe bitmap filters for CS4 and CS5.  This requires a corresponding 

version of Adobe to be installed on the same PC. 
• Improved Color Profiler Engine. 
• Cutter driver options can now be defined per color in the Job Properties dialog.   
• Job Properties will show a cutter tab for contour cut jobs once a cutter has been assigned.  Set 

default cutter in Default Job Properties to avoid having to close and reopen Job Properties after 
assigning a cutter. 

• The Cut/Plot and RIP and Print dialogs will now share the preview between tabs so that a preview 
of the job is always visible. 

• The color selection is now synchronized between preview and driver options in the Cut/Plot 
Dialog.  The color that is selected in the color bar on the preview tab will automatically be 
selected in the driver options. 

• Color adjustment in Job Properties dialog now can be adjusted with higher precision (up to 1%). 
An edit field is added to type in the input value. 

• Auto-serialization feature can now specify different spacing for columns and rows. 
• Poll Size button has been added to Job Properties 
• Drag and Drop images has been added to the Flexi Preferences dialog.  This option defines the 

behavior of dragging and dropping Bitmaps into Flexi.  Choose to either “Always link” or “Always 
embed” the bitmaps 

 
 
 



Miscellaneous changes 
• A new submenu “Send” has been added to the File menu.  Send to Versaworks has been moved 

to the Send submenu.  
• Flexi PRINT&CUT has been replaced by the optional module PlusPRINT, which can be added to 

FlexiEXPERT and FlexiSIGN  
 
Known Limitations 
• Standard Split lines will replace individually set split lines when resizing the graphic in the Cut-

/Plot-Window.  Scaling may result in a change to the object layout and tiling. 
• Ink Estimation does not yet have default dot sizes for all printers.  Updates will be posted as 

available. 
 
Bug Fixes 
• Flexi no longer reports a runtime error at startup on PCs with Adobe PhotoShop CS5 installed. 
• Negative printing now works correctly. 
• Tile printing order now matches the tile map. 
• PDF export no longer crashes when the design has a lens effect with mask. 
• PDF export is no longer missing the image when the file contains a contour path. 
• The round corner tool now works if the angle of the corner is equal or more than 150 degrees. 
• Barbieri LFP now works correctly for the CMYKRGB color mode. 
• Fixed a crash that would occur when variable distortion was applied on variable underbase. 
• Fixed an issue that hitting the reset button on the cutter tab would set the resolution to 0 and 

continue to pop up an error message about the value range being wrong. 
 
New Printer Drivers 
• Allwin: AllWin KONICA 256-42, AllWin KONICA 256-42PL, AllWin KONICA 512-35, AllWin 

KONICA 512-356C, Baod 70, Baod 125 
• Astar: A-Starjet 5, A-Starjet 5.5, Marveljet 
• Blueprint: Blueprint Xaar-382-4C, Blueprint Xaar-382D4-4C, Blueprint Xaar-382-6C, Blueprint 

Xaar-382-60-4C, Blueprint Xaar-382-60-D4C 
• BrPrint: BrPrint 3000, BrPrint 6000, BrPrint 9000 
• Canon: imagePROGRAF iPF650, imagePROGRAF iPF655, imagePROGRAF iPF750, 

imagePROGRAF iPF755, imagePROGRAF iPF8300, imagePROGRAF iPF8310, 
imagePROGRAF iPF6300, imagePROGRAF iPF6350 

• ColorJet: ColorJet KM 512-14, ColorJet KM 512-14-6C, ColorJet KM 512-42, ColorJet KM 512-
42-6C 

• CrystalJet: CJ-F1804SPT255L, CJ-F1804SPT255F, CJ-F1802SPT510_2C, CJ-S1806SPT255L, 
CJ-S1806SPT255F, CJ-S1803SPT510_2C, CJ-F3304IISPT255_12, CJ-S3306IISPT255_12, CJ-
F3308IISPT255_12, CJ-F3304IISPT510_35, CJ-S3306IISPT510_35, CJ-F3308IISPT510_35, CJ-
F3302IISPT510_2C, CJ-S3303IISPT510_2C, CJ-F3304IISPT510_60, CJ-S3306IISPT510_60, 
CJ-F4304SPT510_35, CJ-S4306SPT510_35, CJ-F4308SPT510_35, CJ-F4304SPT510_60, CJ-
S4306SPT510_60, CJ-F4308SPT510_60, CJ-F5308SPT510_35, CJ-F5308SPT255_35, CJ-
S5306SPT510_35, CJ-S5306SPT255_35, CJ-F5304SPT510_35, CJ-F5304SPT255_35, CJ-
F5304IISPT255_12, CJ-S5306IISPT255_12, CJ-F5308IISPT255_12, CJ-F5304IISPT510_35, CJ-
S5306IISPT510_35, CJ-F5308IISPT510_35, CJ-F5304IISPT510_60, CJ-S5306IISPT510_60, 
CJ-F6308SPT510_35, CJ-F6308SPT255_35, CJ-S6306SPT1020, CJ-S6306SPT510_35, CJ-
S6306SPT255_35, CJ-F6304SPT510_35, CJ-F6304SPT255_35, CJ-F6304IISPT510_35, CJ-
S6306IISPT510_35, CJ-F6308IISPT510_35, CJ-F6304IISPT510_60, CJ-S6306IISPT510_60, 
CJ-F6308IISPT510_60, CJ-F6304IISPT1020, CJ-S6306IISPT1020, CJ-F6308IISPT1020, CJ-
F7308SPTGray254, CJ-S7306SPTGray254, CJ-F9312SPT510_35, CJ-F9316SPT510_35, CJ-
F9312SPT510_60, CJ-F9316SPT510_60, CJ-F9304SPT1020_35, CJ-F9308SPT1020_35 

• DG4: DG4-1904, DG4-1908, DG4-2600, DG4-2900, DG4-3300, DG4-7208, DG4-7212, DG4-
7216, DG4-7212 6C, DG4-7218 6C, DG4-7224, DG4-5324, DG4-3400, DG4-5300, DG4-5300 
6C, DG4-SK-3304, DG4-SK-3306 6C, DG4-SK-3308, DG4-SK-3312, DG4-SK-5304, DG4-SK-
5308, DG4-SK-5306 6C, DG4-SK-5312 6C, DG4-SK255-3304, DG4-SK255-3306 6C, DG4UV-
SK-3304, DG4UV-SK-3305 5C, DG4UV-SK-3306 6C, DG4UV-SK-3307 7C, DG4UV-255SK-



3304, DG4UV-255SK-3305 5C, DG4UV-255SK-3306 6C, DG4UV-255SK-3307 7C 
• DGI: PS-3204, PS-3206D 
• DingJie: DingJie DJC-DP-360, DingJie DJC-DP-180, DingJie DJK-3204-SPT510, DingJie DJK-

3206-SPT510, DingJie DJC-3208-SPT510, DingJie DJC-3212-SKW128, DingJie DJR-3208-
Nova256, DingJie DJC-3216-SKW128, DingJie DJEK-3204G-Nova256, DingJie DJX-3204D-
SPT510, DingJie DJX-3208D-SPT510, DingJie DJX-32012D-SPT510, DingJie DJR-32016-
SPT510, DingJie DJC-3208G-SKW128, DingJie DJC-3204G-SKW128 

• Docan: Docan-4C, Docan-5C, Docan-6C, Docan-7C 
• DX-5 Series: DX-5 inkjet, DX-5.5 inkjet, DX-5.5 (6-color) 
• Epson: Stylus Pro 7700, Stylus Pro 9700, Stylus Pro 7710, Stylus Pro 9710, Stylus Pro WT7900, 

Stylus Pro WT7910, PX-W8000, Stylus Pro 3880, Stylus Pro 3880 LA, Stylus Pro 9800 LA, Stylus 
Pro 4900 

• Fei Yeung Union: FY-183, AVANTJET FY-2146, JUMBOJET FY-3266, JUMBOJET FY-3268, FY-
3276, FY-3278 

• FGP: GDN0418-Nova256x4, GDN0418-Nova256x8, GDN0418-Nova256x16, GDN0418-
Polaris512x4, GDN0418-Polaris512x8 

• Fujifilm: UV-900 
• GCC: StellarJET K72UV 
• GongZheng: GongZheng GZE3204AU_4C, GongZheng GZE3203AU_6C, GongZheng 

GZE3202AU_4C, GongZheng GZT_4C, GongZheng GZT_6C, POLARIS 512 
• Hewlet-Packard : DesignJet L65500, HP DesignJet L25500 42, HP DesignJet L25500 60 

DesignJet Z5200, DesignJet T620, DesignJet T770, DesignJet T1200, HP Scitex XP2700 
• HiJet: X6320-A 4C, X6320-A 6C, S6320 4C, X6164-A 4C, X6164-A 6C, X6184-A 4C, X6184-A 

6C, X6184-B 4C, X6184-B 6C, X6320-B 4C, X6320-B 6C, X6250-B 4C, X6250-B 6C, X6164-B 
4C, X6164-B 6C, X8320-B 4C, X7250UV, K8320-A 4C, K6184-B 4C, X8320-A 4C, K7250UV, 
K8320-B 4C, X7250UV, X4320-B 4C, P9320-B 4C 

• Human Digital: HM K-JET 3200, HM K-JET Plus 3200, HM Combo-JET 4800, HM X-Jet Plus 
1800 

• i-Flow: FY1504C, FY6150C, FY1808C, FY6250X, FY33VC, FY33VCX-8, FY33VCX-12, 
FY33VBX, FS8160, FS8160T, FS8250, FS-3316 

• Infiniti: YF-8160III+, YF-8320B, YF-8250B+, YF-1232B+, YF-6250LQ+, YF-3360EC+, YF-
8320LQS, YF-2200S, YF-1633Bnew, YF-8160X+, YF-33VCX, YF-33VBX 

• Jettable: Jettable 
• JinHengFeng: JHF KM512LN4C-USB, JHF KM512LN6C-USB, JHF KM256LN4C-USB, JHF 

KM256LN6C-USB, JHF KM512MN4C-USB, JHF KM512MN6C-USB, JHF KM256MN4C-USB, 
JHF KM256MN6C-USB, JHF-U3312X, JHF-U3308X, JHF-U3306XS, JHF-U3304X, JHF-U5012X, 
JHF-U5008X, JHF-U3312F, JHF-U3308F, JHF-U3306FS, JHF-U3304F, JHF-U5012F, JHF-
U5008F, JHF-U3312FN, JHF-U3308FN, JHF-U3306FNS, JHF-U3304FN, JHF-U3312E, JHF-
U3308E, JHF-U3306ES, JHF-U3304E, JHF-U3312EN, JHF-U3308EN, JHF-U3306ENS, JHF-
U3304EN 

• Leopard: Leopard 3308-8CW 
• Lotus: Lotus ICC XR200 4C, Lotus ICC XR200 6C, Lotus ICC XR720 4C, Lotus ICC XR720 6C, 

Lotus ICC XR382sp 4C, Lotus ICC XR382sp 6C, YinTian ICC XR200 4C, YinTian ICC XR200 
6C, YinTian ICC XR720 4C, YinTian ICC XR720 6C, YinTian ICC XR382sp 4C, YinTian ICC 
XR382sp 6C 

• Micolor: Micolor-4C 
• Mimaki: UJV-110, UJV-160, TCP-1000 
• Mutoh: SpitFire 100 eXtreme, VJ-1204EU (ValueJet), VJ-1604W (ValueJet), VJ-1618A, VJ-

1618W Asia, VJ-1618W-8 Asia, VJ-1304EU (ValueJet), RJ-1300 C, Viper TX Extreme 65, Viper 
TX Extreme 90, VJ-1304W (ValueJet), VJ-1608HA, VJ-1608HEU (Valuejet_Hybrid), Viper TX 
100, VJ-1628TD, VJ-2628TD, VJ1-604EU (ValueJet), VJ-1614EU (ValueJet), VJ-1204A 
(ValueJet), VJ-1304A (ValueJet), VJ-1604A (ValueJet), VJ-1614A(ValueJet) 

• MyJet: MyJet Xaar-128E-4C,  MyJet Xaar-128+E-4C, MyJet Xaar-382-4C, MyJet Xaar-382D4-
4C, MyJet Xaar-382-6C, MyJet k512usb2-14-4c, MyJet k512usb2-14-6c, MyJet k512usb2-42-4c, 
MyJet k512usb2-42-6c, MyJet k256usb2-14-4c, MyJet k256usb2-14-6c, MyJet k256usb2-42-4c, 
MyJet k256usb2-42-6c, MyJet Xaar-382-60-4C, MyJet Xaar-382-60-D4C 



• Neo: NEO FENIX KM32-6, NEO FENIX KM32-4, NEO UV-LED X25-16, NEO UV-LED X25-12, 
NEO UV-LED X25-8, NEO UV-LED X18-16, NEO UV-LED X18-12, NEO UV-LED X18-8, NEO 
UV-LED KM18-8, NEO UV-LED KM18-6, NEO UV-LED KM25-8, NEO UV-LED KM25-6, NEO UV 
X18-16, NEO UV X18-12, NEO UV X18-8, NEO UV X18-6, NEO UV X18-4, NEO DRAKAR X32-
16, NEO DRAKAR X32-12, NEO DRAKAR X32-8, NEO KATRAN X18-16, NEO KATRAN X18-
12, NEO KATRAN X18-8, NEO KATRAN X18-6, NEO KATRAN X18-4, NEO UV-LED Evolution 
KM, NEO UV-LED Evolution Compact KM, NEO UV-LED Evolution Flatbed KM, NEO UV-LED 
Evolution Flatbed 2KM, NEO UV-LED Evolution S, NEO UV-LED Evolution Compact S, NEO UV-
LED Evolution Flatbed S, NEO UV-LED Evolution Flatbed 2S 

• Neolt: SuperJet M 2050 UV, AsterJet 1650, AsterJet 2050 
• Phaeton: UD-3206S, UD-2506S, UD-1806S, UD-3206B, UD-2506BF, UD-1806BF, ,UD-2504S, 

UD-2104S, UD-3204B, UD-323B, UD-213B, UD-183B, UD-212H, UD-252, UD-2128H, UD-2528, 
UD-2146H, UD-3268D, UD-3264D, UD-3208  

• PrismaJet: PrismaJet GE-1802-S, PrismaJet GE-1802-DS, PrismaJet FP-3204-S, PrismaJet JK-
1804-S, PrismaJet JK-2504-S 

• PrismJet: PrismJet VJ48 
• Roland: VersaCAMM VP-300i, VersaCAMM VP-540i, AdvancedJET AJ-740i, AdvancedJET AJ-

1000i, SOLJET PRO III XC-540MT, SOLJET PRO III VS-640, VersaCAMM SP-540i, 
VersaCAMM SP-300i, VersaUV LEC-330 

• Scorpion: Scorpion 3300 INNO, Scorpion 1650 Turbo INNO 
• Seiko Instruments: LP-1020, LP-1020L, LP-1020-MF, LP-1020L-MF 
• SID Signs: SID XCS-320-8H, SID XE-210 6C, SID XE-250 4C, SID XE-250 6C, SID XE-320 4C, 

SID XES-320-4C, SID XH-250 4C, SID XQ-210 4C, SID XQ-210 6C, SID XPS 320-8H, SID US-
320-8H, SID XCS Plus 320-8H, SID XES 250-6C, SID XES 250-4C, SID UV 200 S, SID XC-II-
320-6c, SID XPRESS-8H 

• Sky Air: SKYJET-3300-4C, SKYJET-3300-6C, SKYJET-5200-4C, SKYJET-5200-6C, SKYKJET-
2600UV-4C, SKYKJET-2600UV-6C 

• Solaris: Solaris 1802, Solaris 1804 
• Sprinter: Sprinter Xaar-382-4C, Sprinter Xaar-382D4-4C, Sprinter Xaar-382-6C, Sprinter Xaar-

382-60-4C, Sprinter Xaar-382-60-D4C 
• ThunderJet: ThunderJet V1802 
• Titan: TJ-33 
• Twinjet: Twinjet 1816, Twinjet 1804, Twinjet 1804 (6-color), Twinjet 1804 (8-color) 
• UVPrinter: UVPrinter 
• WanZhen: WZ-4C, WZ-5C, WZ-6C, WZ-7C 
• Witcolor : Ultra3000, HB2544 
• YongLi: YL-4C, YL-6C, Large Format Printer 

 
 

New Cutter Drivers 
• ACS: S13, S15, S24, S30, S40, S48, S60, S13-USB, S15-USB, S24-USB, S30-USB, S40-USB, 

S48-USB, S60-USB, C13, C15, C24, C30, C40, C48, C60 
• Creation PCut: CS-630G, CS-1200G 
• Evolus: EVS30, EVS60, EVS76, EVS90, EVS120, EVS30-USB, EVS60-USB, EVS76-USB, 

EVS90-USB, EVS120-USB, EV30, EV60, EV76, EV90, EV120 
• GCC: Expert-24 
• Gerber: Tempo-600 
• Goldcut : GC-12, GC-24, GC-30, GC-48, JK-240, JK-330, JK-365, JK-720, JK-870, JK-1100, JK-

1350 
• ICutter: S12, S24, S36, S48, S12-USB, S24-USB, S36-USB, S48-USB, V12, V24, V36, V48 
• I-Flow: S12, S24, S30, S36, S48, S12-USB, S24-USB, S30-USB, S36-USB, S48-USB, C12, C24, 

C30, C36, C48 
• LiYu Cut: TC Series, SF Series, HC Series, TL Series, SL Series 
• Mimaki: CG-100SRII, CG-130SRII 
• Mutoh: KONA 760, KONA 1400, KONA 1650 
• RedSail Tech: RS1360D 



• Refine-Cut: ECO Series, PRO Series, SP Series 
• Roland: GX-640 
• US Cutter: US Cutter ZenCut Green 24", US Cutter ZenCut Green 52", US Cutter ZenCut Black 

24", US Cutter ZenCut Black 40", US Cutter ZenCut Black 52", US Cutter ZenCut Black 72" 
 
 
 


